
Metodický materiál k cvičením s 3D 

daty pro předmět AGI 

Cv1 - Digitální vyjádření zemského povrchu 
 
Vstupní data: 

Pro toto cvičení budeme používat data, která jsou ke stažení na coursewaru předmětu AGI. 

Lze je najít na záložce cvičení u části Materiály ke cvičení. Konkrétně se jedná o data “01 Vliv 

povinných hran na TIN”. V těchto datech se nachází geodatabáze s názvem Kozel_shrnuti.gdb a její 

součástí jsou vrstvy: ​ AreaLP,   

HranyBudovL,  

TerenniHrany3DL,  

Vodstvo3DL,  

VrstevniceL. 

 

Naše zadání zní: 

Ze vstupních dat vytvořte:  

–Nepravidelnou trojúhelníkovou síť bez povinných hran 

»Co použijete za vrstvy?  

 

–Nepravidelnou trojúhelníkovou síť s povinnými hranami  

»Co použijete za vrstvy?  

 

–Objemovou analýzou srovnejte obě vytvořené trojúhelníkové sítě 

»Jakou funkci použijete? 

 

–Vyberte oblast, ve které je možné povinnou hranou zlepšit průběh terénu a takovou hranu 

vytvořte. 

 

Řešení: 

1. Nejdříve si stáhneme vstupní data a založíme nový projekt v ArcGIS Pro. Následným 

způsobem:  

Po spuštění ArcGIS Pro zvolíme možnost Map, z nabízených šablon a poté vytvoříme nový 

projekt. 



 

 

2. Přidáme data tak, že v záložce Map zvolíme Add Data. 

 

Poté se navigujeme do složky s našimi staženými daty a zde si vybereme vrstvy AreaLP,  

HranyBudovL, TerenniHrany3DL, Vodstvo3DL, VrstevniceL. Po přidání jednotlivých vrstev by se nám 

měl zobrazit takovýto obrázek: 



 

 

3. Vytvoříme TIN bez terénních hran pomocí funkce Create TIN. Vstupními daty budou 

VrstevniceL a ArealP.  



 

 

Výsledek se nám zobrazí takto: 



 

 

 



4. Vytvoříme TIN s terénními hranami pomocí funkce Create TIN. Vstupními daty budou 

AreaLP,  HranyBudovL, TerenniHrany3DL, Vodstvo3DL, VrstevniceL. 

 

 

Na výsledku jsou oproti předešlému výsledku jasně patrné terénní hrany. 



 

 

4. Porovnání TIN objemovou analýzou 

K porovnání použijeme funkci Surface Difference a na vstupu této funkce budou naše 

výsledné TIN s hranami a bez hran. 



 

 



 

 

 

 



5. Převedeme z 2D do 3D 

V záložce View vybereme Convert to Local Scene. 

 

 

Protože se nám ale TIN zobrazí na defaultní referenční plochu je nutné nejdříve nastavit 

plochu na náš TIN. V table of contents vybereme záložku Ground a nad ním vybereme Add 

elevation Source a zde vybereme naše vytvořené TIN.  

 

 

Výsledek se zobrazí takto: 

TIN s hranami 



 

TIN bez hran 

 



6. Přidání terénní hrany ručně 

Pokud chceme přidat vlastní terénní hranu, tak v table of contents vybereme TIN a v záložce 

Data vybereme TIN Editor. 

 

7. Pokládání vrstev na terén  

Položení 2D vrstvy na terén lze pomocí funkce polygon to multipatch. Ukážeme si na to na příkladu s 

vrstvou KomunikaceP. Nejdříve přídáme již zmíněnou vrstvu a ta se nám zobrazí takto:  

 

Je patrné, že vrstva s komunikacemi se zobrazila pouze v rovině a vrstva s terénem(TIN s hranami) je 

vidět nad ní. Nyní použijeme funkci polygon to multipatch.  



 

Výsledek se zobrazí takto: 

 



 

 

 

 

 

 

 
 



Cv2 - Modelování výškové dimenze prvků 
Vstupní data: 

Pro toto cvičení budeme používat data, která jsou ke stažení na coursewaru předmětu AGI. 

Lze je najít na záložce cvičení u části Materiály ke cvičení. Konkrétně se jedná o data “02-03 

2,5D and 3D data”. V těchto datech se nachází složka ArcGIS a v ní najdeme TIN pro zámek 

Kozel pojmenovaný “TINArealuKozlu” a také geodatabázi Kozel3D.gdb, jejíž součástí jsou 

feature datasety, ve kterých jsou uložené údaje o všech budovách a detailně o zámecké 

kapli. 

 
Naše zadání zní: 

Vytvořte 2,5D reprezentaci zámeckých budov.  
–V datech nalezněte prvkovou třídu reprezentující budovy. 

–Použijte funkci extrudek vytažení výšky budov podle zvolené konstanty. 
 
Vytvořte 2,5D reprezentaci zámecké kaple. 
–Ve zdrojových datech nalezněte třídy vztahující se k zámecké kapli 

–Vytáhněte výšky jednotlivých tříd na základě odpovídajících atributů. 
 
Poznámka 
0.  Vytvoření 3D modelu z půdorysu - Dataset obsahuje půdorys Budova. Jedná se o 

pravoúhlý polygon. V atributové tabulce objektu můžeme vidět, připravené kolonky s 

absolutní a relativní výškou. Tyto hodnoty jsou prázdné - jedná se zatím pouze o půdorys, 

tudíž u něj nepotřebujeme znát žádnou výšku. Tyto hodnoty však můžeme vyplnit a vytvořit 
tak z půdorysu 3D objekt následujícím způbem: 

1)​ Budova -> Atribute table - vyplníme hodnoty pro relativní a absolutní výšku (například 

20 metrů) 

2)​ Následně v záložce Feature Layer nastavíme v Type: Max Height hodnotu atributu 

Field nastavíme například jako absolutní výšku. ArcGIS Pro automaticky změní tento 

2D objekt na 3D a vykreslí jej. Nyní tedy máme z půdorysu (z LOD0) LOD1 budovu. 

Pokud by byl objekt datatype line, vytvořila by se zeď, pokud by se jednalo o point, 

výsledným objektem by byl sloup. 



 

Řešení cvičení: 

1. Nejdříve si stáhneme vstupní data a založíme nový projekt v ArcGIS Pro. Následným 

způsobem:  

Po spuštění ArcGIS Pro zvolíme možnost Local Scene, z nabízených šablon a poté vytvoříme 

nový projekt. 



 

 

2. Přidáme data tak, že v záložce Map zvolíme Add Data. 

 

Poté se navigujeme do složky s našimi staženými daty a zde si vybereme vrstvy 
TINArealuKozlu a také vrstvu Budovy z feature datasetu Vysky_3D. TINArealuKozlu ještě použijeme 

jako povrchovou plochu. Po přidání jednotlivých vrstev a nastavení povrchu by se nám měl zobrazit 

takovýto obrázek: 



 



3. Použijeme funkci extrude na vytažení výšky všech budov. Extrude lze nalézt po vybrání 

vrstvy z budovami v záložce Appearance. Zde vybereme Absolute Height.

 

Budovy se poté zobrazí takto: 



 

Pokud chceme jednotlivé budovy vytáhnout o různou velikost tak vybereme možnost 

Extrusion Expression, která se nachazí vedle Extrude. 

 

Zde můžeme nastavit zvýšení o jakoukoliv hodnotu například o 10 m. 



 

Výsledek se zobrazí takto: 



 

4. Pro vytvoření zámecké kaple si přidáme všechny vrstvy kromě komunikace, které se 

nacházejí v feature datasetu Vysky_2_5D.  Po přidání dostaneme tento výsledek: 



 

Nyní je potřeba jednotlivé vrstvy vytáhnout pomocí Extrude Expression. Ve všech případech 

vytáhneme jednotlivé části kaple o absolutní výšky a jejich relativní výšku. Vrstvy končící na 

_1 určují druhé patro. 



 

Výsledek vytažení všech vrstev bude vypadat takto: 



 



 



 

Budovy lze také zobrazit jejich 3D modelem, přidáme vrstvu BudovyLOD3. Budovy poté 

vypadají takto:  

 



 

Cv3 - 3D editace v GIS 
Vstupní data: 

Pro toto cvičení budeme používat data, která jsou ke stažení na coursewaru předmětu AGI. 

Lze je najít na záložce cvičení u části Materiály ke cvičení. Konkrétně se jedná o data “02-03 

2,5D and 3D data”. V těchto datech se nachází složka ArcGIS a v ní najdeme TIN pro zámek 

Kozel pojmenovaný “TINArealuKozlu” a také geodatabázi Kozel3D.gdb, jejíž součástí jsou 

feature datasety, ve kterých jsou uložené údaje o všech budovách a detailně o zámecké 

kapli. 

 

Naše zadání zní: 

-​ Vytvořit 3D budovu ve vstupních datech z již existujícího půdorysu 

-​ Vytvořit (vymodelovat) nový 3D objekt 

-​ Objekt různě upravit (střecha, textury, velikost, natočení, slice, atd.) 

-​ Import a export objektu (feature) 

 

1.​Tvorba 3D modelu 
Řešení: 

1. Nejdříve si stáhneme vstupní data a založíme nový projekt v ArcGIS Pro. Postup je popsaný 

například ve druhém cvičení. 



2. Po spuštění ArcGIS Pro zvolíme možnost Local Scene, z nabízených šablon a poté 

vytvoříme nový projekt. Postup je taktéž popsaný ve druhém cvičení. 

 

3. Nyní bychom chtěli vytvořit budovu bez využití předem připraveného půdorysu. Musíme si 

tedy nejdříve vytvořit náš vlastní polygon. Tento polygon budeme následně převádět do 3D. 

Abychom tak mohli učinit, musíme použít multipatch feature class nebo 3D object feature 

class. 

Odkaz na video s tvorbou 3D budovy zde. Pozor, ve videu není vidět přepínání editačních 

nástrojů: 

 

Přepínání editačních nástrojů je ukázáno na obrázcích doprovácejících text níže. 

3.1.  V Catalog -> Databases -> Kozel3D.gdb -> klikneme pravým tlačítkem na New -> 

Feature Class. Nastavíme jméno (například Building3D). Jako typ zvolíme multipatch. 

-> Finish 

.2.  Nastavíme v Symbology jinou barvu pro lepší přehlednost (například Orange with 

edges). 

.3.  Následně začneme kreslit (editovat/modelovat) objekt. Edit -> Create Feature v 

Building3D - > Create 3D Geometry 

 

.4. Začneme kreslit půdorys (pravoúhlý polygon - obdélník). K lepší orientaci nám 

slouží podkladová vrstva, na které jsou půdorysy staveb. Nám tedy stačí pomocí 4 

bodů tento půdorys zachytit (popřípadě zvolit uprostřed obrazovky vykreslení 

square). Zvolíme tedy parcelu umístěnou naproti námi již dříve vytvořené budově 

(bod 2).  

https://youtu.be/MUhkRqfuOBs


  

3.5.  Nyní půdorys vytáhneme do prostoru a vytvoříme tak 3D objekt. Najetím myší 

na obdélník se zobrazí koule sloužící k tomuto účelu. Objekt tedy vytáhneme do 

zhruba 20 metrů. Nyní již máme 3D budovu. 

 

3.6.  Přiděláme střechu. Uprostřed kratší zdi budovy (prostředek se pozná podle toho, 

že se kurzor změní na křížek) k prostředku protější zdi vytvoříme linii. Na vytvořené 

lini se znovu objeví koule pro posun výšky. Posunutím nahoru vytvoříme tvar střechy. 



 

3.7.  Střechu můžeme doplnit dalšími tvary. Vybízí se komín. Na střeše tedy 

vytvoříme obdélník a ten znovu vytáhneme do prostoru. Zde si však kvůli náklonu 

střechy musíme dát pozor podle jaké osy komín do prostoru vytáhneme. 

 

3.8.  Abychom komín udělali o něco reálnější, vytvoříme na něj dva sloupy 

představující vývody komínu. Postup bude obdobný, ale nebudeme vytvářet 

čtyřúhelník, ale kruh, který následně vytáhneme do prostoru. 



  

 

Tímto postupem můžeme vytvářet například balkony, terasy, garáže přilehlé k 

budově a podobně. 

Naopak invertním postupem (nevytažením objektu do prostoru, ale zatlačením do 

budovy) můžeme vytvořit například vchody, průchody budovou nebo rámy oken. To 

však kdybychom chtěli detailnější model, což není účelem tohoto cvičení. 

Pokud bychom přeci jen chtěli, aby budova vypadala realisticky, přidáme textury. K 

tomu nám stačí dva texture obrázky (pro zdi budovy a pro střechu). Tyto obrázku lze 

volně sehant jako stock pictures na internetu. Libovolné dva obrázky tedy stáhneme 

do počítače a přidělíme multipatchy. Následovně: 

Modify Feature -> Multipatch Texture -> Load Texture -> Vybereme texturu pro stěny 

a jednotlivě je na modelu označíme. Stejně postupujeme i u střechy. Jeden z 

možných výsledků je možné vidět na následujícím obrázku. Stále se samozřejmě 

nejedná o perfektní zobrazení domu, avšak s kvalitně připravenými texturami se k 

tomuto stavu můžeme přiblížit. 



  

3.8. Nyní zkusíme z jedné 3D budovy vytvořit dvě. K tomu slouží funkce Slice 

Multipatch. Modify -> Slice Multipatch -> Vertical, Solid 

 

V prvkové třídě  nám přibyl nový objekt, nyní máme dvě budovy a každou tedy můžeme 

upravovat zvlášť. 

 

 

 



2.​Export a import modelu 
 

Máme dva objekty. Pro ukázku exportu a importu 

si budovu označenou v atributové tabulce jako 

Object1 exportujeme a pak si jí znovu 

importujeme a budeme jí tedy mít v projektu 

dvakrát. 

Export: Pravým tlačítkem na Building3D -> Data 

-> Export Features -> Nastavíme název a složku, 

do které se feature uloží, dále nastavíme filtr, 

chceme vybrat pouze první budovu (OBJECTID is 

equal 1). -> OK 

Export se nám hned zobrazí ve scéně. My si jej 

však chceme zkusit naimportovat, a proto náhled 

na něj smažeme Building3D_Export -> Remove. 

Pozn. pokud bychom chtěli exportovat model jako Collada, existuje v ArcGIS Pro funkce Multipatch to 

Collada.  

Import: Catalog -> Building3D -> Load Data -> Input dataset = námi vytvořený a exportovaný soubor 

Building3D_Export (u tohoto kroku se také nachází filtr, tudíž i zde lze vybírat jednotlivé objekty, které 

se přidají, my však máme pouze jeden) -> Run 

Výsledkem importu je další objekt ve vrstvě Building3D. Tento objekt je přesnou kopií prvního objektu 

a nachází se tedy i na stejném místě. Objekt tedy označíme a pomocí Edit -> Move jej přesuneme na 

jiné místo. Na obrázku níže jde vidět výsledek, tedy tři LOD2 budovy. 

 

 

 



3.​Spojení několika objektů 
 

Nyní bychom chtěli znovu vytvořit budovu, kterou jsme vytvořili na začátku. Vybereme budovu 

OBJECTID = 1 a pomocí Edit -> Move ji přesuneme k budově OBJECTID = 2. Následně pomocí funkce 

Merge Features -> Merge tyto objekty spojíme v jeden. Nyní tedy máme v atributové tabulce pouze 

dva záznamy a to budovu, kterou jsme na začátku vytvořili a exportovaný a následně importovaný kus 

této budovy. 

 

 

 

 

 

 

 

 

 

 

 

 

 



Cv4 – Procedurální modelování stromů 
 

Nyní přidáme do naší zájmové oblasti vegetaci. Přesněji, vygenerujeme několik stromů.  

Nejdříve si do projektu přidáme DMR a DMP zájmové oblasti. Poté tyto TIN vrstvy převedeme na 

raster (TINToRaster -> nastavíme Cell size na 1 metr).  

Následně máme tedy dva rastery. Ty od sebe odečteme (funkce Minus), přesněji odečteme DMR od 

DMP. 

Z výsledného rastru vybereme jen zájmovou oblast, ve které by se mohla nacházet vegetace. Funkcí 

Extract by Atribute (VALUE < 1 a VALUE > 0). Nyní jsme 

získali rastr představující plochu, ve které by se mohly 

nacházet stromy. 

 

Z námi vytvořeného rastru si nejdříve vytvoříme multipoint 

(RasterToMultipoint).  

 

Nyní náhodně vygenerujeme několik bodů, které budou 

představovat jednotlivé stromy. Využijeme nástroj 

CreateRandomPoints, kde nastavíme počet bodů a 

minimální vzdálenost mezi nimi. (V ukázce 300 bodů a 3 

metry). Vstupem je námi vytvořená polygonová vrstva.​
Výzva: navrhněte postup, kterým pokryjete různě veliké 

plochy (polygony) homogenní hustotou náhodných stromů.   

 

 

Nyní máme vrstvu s vygenerovanými body. Následně 

pomocí (AddField) přidáme pole “height” představující 

výšku stromu. Toto pole naplníme náhodnými hodnotami v 

rozmezí od 5 do 20 (CalculateField  -> radnom.randint(10,20)).  

 

Aby se velikost bodů měnila podle výšky, musíme v symbologii vrstvy nastavit “Vary symbology by 

attribute” na “Size” a zde zvolit námi vytvořený atribut “Height”. Důležité je také bodovou vrstvu 

stromů v panelu Contents přesunout pod 3D Layers. Pokud chceme, aby stromy měly výšku v 

reálných jednotkách (metrech) podle pole “height”, musíme ještě v panelu Contents kliknout pravým 

tlačítkem na vrstvu stromů  -> Properties -> Display a zde zaškrtnout možnost Display 3D symbols in 

real-world units. Díky tomu se nám velikost symbolů přepne z jednotek pt do metrů a nebude závislá 

na aktuálním přiblížení pohledu.  

 

 



 

 

 

 

Software ArcGIS Pro obsahuje několik 3D znaků vegetace. Je však potřeba je nejdříve přidat a to 

použitím nástroje “Add System Style”. V symbology poté vybereme nějaký model stromu (na obrázku 

je použit “European Larch”).  

Výzva:  

●​ náhodně vygenerujte alespoň dva druhy stromů (listnaté a jehličnaté).  

●​ stromy od 5 do 10m výšky kreslete jiným symbolem než stromy vyšší (jak listnané, tak 

jehličnaté) 

●​ procvičený postup procedurálního modelování adaptujte na vrstvu existujících 

stromů a na její atributy obsahující výšku stromu a druh stromu 

 

 

 



Ukázka procedurální modelace střech v ArcGIS Pro zde. 

 

Cv5 - Analytický 3D GIS 
(záznam přednášky, zdroj cvičení) 

Vstupní data: 

Pro toto cvičení budeme používat data, která jsou ke stažení na coursewaru předmětu AGI. 

Lze je najít na záložce cvičení u části Materiály ke cvičení. Konkrétně se jedná o data “04 

Analýzy ve 3D”. V těchto datech se nachází složka AnalyzyVe3D a v ní najdeme vrstvy:  

-​ BodyVe3D 

-​ BudovyLOD3 

-​ Garaze 

-​ ObservacniBod 

-​ tin 

 
Naše zadání zní: 

-​ Vyzkoušejte následující funkce: 
-​ Visibility 
-​ Výpočet zakrytí obzoru: 

-​ SkyLine 
-​ SkyLine Barrier 
-​ SkyLine Graph 

-​ Inside 3D: 
-​ Inside 3D 
-​ Is Closed 3D 
-​ Enclose MultiPatch 
-​ Inside 3D 

-​ Buffer 3D 
-​ Intersect 3D 
-​ Difference 3D 

-​ Body-Garaze 
-​ Garaze-Body 

-​ SunShadowVolume 
-​ Near 3D 

 
 
Řešení: 

1. Nejdříve si stáhneme vstupní data a založíme nový projekt v ArcGIS Pro. Následným 

způsobem:  

Po spuštění ArcGIS Pro zvolíme možnost Local Scene, z nabízených šablon a poté vytvoříme 

nový projekt. 

https://docs.google.com/document/d/1H1HYkACA6wvRN_p9Zrm1ARCWnDC7f6rQ_HKrpC4MjS0/edit#heading=h.62mukpx9rvel
https://youtu.be/_XTJEfhdwLk?list=PLAfuGLooI6KzcacSFG_6rrJXKUI3SMAmn&t=1793
https://docs.google.com/document/d/1-ZwEQ_h_F8rT1ckwFo-xKEpTYiT8iY0riumBjbv6aRY/edit#heading=h.fexdt2u2czi7


 

 

2. Přidáme data tak, že v záložce Map zvolíme Add Data.  

 

Poté se navigujeme do složky s našimi staženými daty a zde si vybereme všechny vrstvy. Po 

přidání jednotlivých vrstev a nastavení povrchu podle TIN by se nám měl zobrazit takovýto obrázek1: 

1 https://pro.arcgis.com/en/pro-app/latest/help/data/tin/use-tin-in-a-scene-view.htm  

https://pro.arcgis.com/en/pro-app/latest/help/data/tin/use-tin-in-a-scene-view.htm


 

Pozor, TIN je potřeba přidat do skupiny Ground a vypnout default povrch. Tato akce přidá neviditelný 

povrch, ke kterému je možno referencovat další vrstvy. Chceme-li TIN zároveň i zobrazit, je potřeba 

jej přidat i jako 2D vrstvu: 



 

3. Spuštění jednotlivých funkcí:  

Visibility  

Nástroj, který detekuje část povrchu rastru viditelnou z určitého místa či míst nebo zjistí, která místa 

jsou z jednotlivých buněk rastru viditelná. Abychom mohli použít funkci Visibility, musíme nejdříve 

vytvořit rastr z našeho TINu.  



 

Výsledný rastr bude vypadat takto: 

 

Vstup: 



Input rastr - rastr povrchu 

Input point or polyline observer features - bodová nebo liniová feature class, která reprezentuje místo 

pozorování  

Output raster - výsledný rastr viditelnosti 

 

Mezi volitelné parametry nastavení patří: Output above Ground level raster (rastr obsahující hodnotu 

výšky, která musí být přidána k výšce buňky, aby byla vidět alespoň z jednoho pozorovacího místa) 

Analysis type (FREQUENCY - rozdělení rastru na buňky, které jsou a nejsou viditelné, OBSERVERS - určí 

jaké body jsou viditelné z jednotlivých buněk rastru, pouze pro bodovou featur class), Z factor (počet 

jednotek polohy x,y na jednotku výšky, pokud jsou jednotky stejné bude 1) a další nastavení 

(Observer parametres) 

Nyní použijeme funkci Visibility. V prvním případě místo, ze kterého chceme viditelnost zjistit bude 

pouze jeden observační bod. V druhém případě použijeme všechny body. 

Visibility pro observační bod: 

 



 

Visibility pro body: 

 



 

 

Výpočet zakrytí obzoru: 

Skyline (3D Analyst) 

Nástroj generuje linii nebo multipatch znázorňující obzor. 



 

Vstup: 

Input Observer Point Features - 3D body reprezentující místa pozorovaní 

Output Feature Class - 3D prvek, linie nebo multipatch reprezentující obzor 

 

Mezi volitelné parametry patří: Input surface (topografický povrch, pokud není žádný zvolený použije 

se virtuální povrch), parametry virtuálního povrchu (Virtual Surface Radius, Virtual Surface Elevation), 

Input Features (prvky určující obzor), Featur Level of Detail (úroveň detailu prvků) a další nastavení 

(Azimuths, Skyline Options, Scaling Options, Surface Options) 



 

SkyLine Barrier (3D Analyst) 

Nástroj generující multipatch, který reprezentuje bariéru vytvářenou linií obzoru 



 

Vstup: 

Input Observer Point Features - feature class obsahující místa pozorovaní 

Input Features - feature class nebo multipatch reprezentující obzor 

Output Feature Class - výsledná feature class obsahující bariéru 

Mezi volitelné parametry patří: Minimum Radius, Maximum Radius a Base Elevation (nastavení 

parametrů bariéry) 



 

6. SkyLine Graph 

Tato funkce ve verzi 2.6.3 ArcGIS Pro nefunguje. Jediným výsledkem je pouze tabulka s 

hodnotami, graf se nevytvoří. 

 



Inside: 

Is Closed 3D (3D Analyst) 

Nástroj zjistí, které objekty jsou zcela uzavřené. 

 

 

Vstup: 

Input Multipatch Features - multipatch, který má být otestován 

 

 

Enclose Multipatch (3D Analyst) 

Z vybraného multipatche vytvoří nový multipatch, ve kterém budou všechny prvky uzavřené. 



 

Vstup: 

Input Multipatch Features - multipatch, jehož prvky mají být uzavřeny 

Output Multipatch Features - výsledný multipatch obsahující uzavřené prvky 

 

Mezi volitelné parametry patří: Grid Size (rozlišení) 

 

 

 

Buffer 3D (3D Analyst) 

Nástroj vytvoří 3D obalovou zónu kolem bodů nebo linií. 



 

Vstup: 

Input Features - body nebo linie 

Output Feature Class - výsledný multipatch obsahující 3D obalovou zónu 

Distance - vzdálenost, ve které má být obal vytvořen, může být buď ručně zadána nebo může být 

odvozena z hodnot ve sloupci atributové tabulky 

 

Mezi volitelné parametry patří: Joint Type (tvar spojnice mezi vrcholy obalu - rovná nebo zakřivená), 

Buffer Quality (nastavení vyhlazení obalu), Simplification (zjednodušení zadané linie) 



 

 

Inside 3D (3D Analyst) 

Nástroj zjistí, jestli se zvolená feasture class nachází uvnitř uzavřeného multipatche a vypíše, které 

prvky jsou částečně uvnitř nebo zcela uvnitř multipatche. 

 

Vstup: 

Input Features - multipatch, 3D bodová, lin iová nebo polygonová feature class, kterou chceme 

analyzovat 



Input Multipatch Features - uzavřený multipatch 

Output Table - tabulka s výsledky 

 

Mezi volitelné parametry patří: Complex Output Table  (tabulka poskytne komplexnější výsledky pro 

vzájemné vztahy prvků) 

 

 

 

 

 

Intersect 3D (3D Analyst) 

Nástroj vrací multipatch obsahující průnik prvků (může se jednat o těleso, plochu nebo linii). 

 



 

Vstup: 

Input Multipatch Features - multipatch z jehož prvků bude počítán průnik, pokud je zadán pouze 

jeden multipatch spočte se vzájemný průnik jeho prvků 

Output Feature Class - feature class obsahující výsledný průnik 

 

Mezi volitelné parametry patří: Input Multipatch Features (druhý multipatch, vypočte se jeho průnik s 

prvním zadaným multipatchem), Output Geometry Type (SOLID, SURFACE, LINE - dimenze, ve které se 

hledá průnik) 



 

Difference 3D (3D Analyst) 

Nástroj vygeneruje množinový rozdíl dvou multipatchů 

 

 



Vstup: 

Input Features - multipatch, od kterého se bude odečítat 

Substrakt Features - multipatch, který bude odečten 

Output Feature Class - výsledný multipatch 

 

Mezi volitelné parametry patří: Output Table (obsahuje informace o vztazích mezi prvky) 

 



 

 

 

Sun ShadowVolume (3D Analyst) 

Nástroj vytvoří za pomoci slunečního světla v daný den a čas model stínu pro každý zadaný prvek. 



 

Vstup: 

Input Features - multipatch nebo vytažená vrstva 3D polygonů nebo linií, která bude použita pro 

tvorbu stínů 

Start Date and Time - datum a čas pro výpočet trajektorie slunce 

Output Feature Class - výsledný multipatch 

 

Mezi volitelné parametry patří: Time Zone (časové pásmo), End Date and Time (cílové datum a čas, 

pokud není zvoleno je uvažován západ slunce), Iteration Interval (interval pro iteraci času), Iteration 

Units (iterační jednotky) 

 

 

 



 

Near 3D (3D Analyst) 

Nástroj, který spočte prostorovou vzdálenost každého objektu v feature class k jeho nejbližšímu 

objektu v jiné feature class 

 

 



Vstup: 

Input Features - feature class, k jejímž objektům bude přidána atributová informace o nejbližším 

prvku 

Near Features - jedna a nebo více feature class, z jejichž objektů se bude vybírat nejbližší 

 

Mezi volitelné parametry patří: Search Radius (maximální vzdálenost pro nejbližší objekt), další 

informace o nejbližším prvku, které mohou být přidány do atributové tabulky (Location, Angle, Delta) 

 

 

Rozšiřující cvičení 
 Doplnění metodického návodu pro práci s 3D daty v GIS

https://docs.google.com/document/d/1wlBTe7uDgsReqe6HmkyfOY2PGS7eFAAQQS9RO9wMvT0/edit
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